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ABSTRACT

SAS® Enterprise Guide® 5.1 introduces the concept of reusable, query-based templates. SAS Enterprise Guide users
have been able to create task templates to save custom settings for some time now. Query-based templates offer the
ability to create similar functionality from the SAS Enterprise Guide Query Builder. These templates allow speedy
access to previously designed queries that might have included time-consuming work spent fashioning the perfect
table join, computed column, or filter. SAS Enterprise Guide 5.1 also allows you to reuse certain types of query-based
templates as subqueries in computed columns and filters. This paper describes how query-based templates work and
how to use them to answer special problems by turning them into subqueries in the point-and-click Query Builder
interface.

INTRODUCTION
BACKGROUND ON TASK TEMPLATES IN SAS ENTERPRISE GUIDE

SAS Enterprise Guide 4.2 introduced the ability to create task templates. Consider the Bar Chart task. You can
spend a great deal of time customizing the settings for the resulting chart’'s appearance. You work to modify options
such as custom colors, formatting how the axes will display, and customizing the legend in order to produce an image
that describes your particular data clearly and with a style matching the preferences of you and your organization.

Task templates allow you to save those choices by selecting the Create Template option from a drop-down list that is
available in most tasks.
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Display 1. Option to Create a Task Template in the Bar Chart Task
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Display 2. Dialog Box Allowing You to Describe and Create a Task Template

The Create Task Template dialog box appears after you select Create Template. In this dialog box, you specify the
name of the template and where to save the template.



SAS Global Forum 2012 SAS® Enterprise Guide® Implementation and Usage

Finding Your Inner Query with SAS® Enterprise Guide®

File Edit View | Tasks | Program Tools Help | S-S5~ 05| & e A R W Y e
r  Tree Data »
E“g?g Process Flow Pecribe i | Export = Schedule ~ | Zoom ~ |[Z& ProjectLog | ::
=-Eg4 CLASS Graph C e
il Bar Char &b it
ANOVA s nﬂﬂ __,
Regression »
Bar Chart SAS Report
Multivariate ] - Bar Cha... = u.
Survival Analysis — »
Capability »
Control Charts » w
filw Pareto Chart...
Time Series »
a @ ® B Model Scoring...
| Task Tempiates OLAP b
il My bar chart ternp| Task Templates r Task Template Manager...
This is my custom bar chart
il My bar chart template..,
—_—
1| i 3 <] = | ;
Ready | % Mo connection

Display 3. How to Start a Task Template You Have Previously Saved

After the template is created, you can quickly reproduce similarly styled charts based on different data or with
different roles. You access the saved template from the Template Manager, or by selecting the template name from
Tasks->Task Templates.

When you open a previously saved task template, a task of the type you saved starts. The task options are already
filled in with the settings that you specified for the template. However, settings that are data specific are not saved
with a task template. For example, any task roles that you assigned and the actual input data are not saved as part
of your template. When you select the template, the task uses the data that is currently selected in the process flow,
or if there is no data is selected, a file selection dialog box appears so you can choose the input data. After the input
data is selected, task roles need to be assigned before you can run the new task.
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Display 4. Task Role Settings Are Not Saved in Task Templates

QUERY-BASED TASK TEMPLATES AND SUBQUERIES IN SAS ENTERPRISE GUIDE 5.1

The initial concept of task templates in SAS Enterprise Guide did not include any work that you might have done in
the Query Builder. Task templates were meant to save custom settings, but were designed to be a data independent
so they could be used again quickly on any input data source. In contrast, work done in the Query Builder is all about
data.

In the Query Builder, there are fewer data independent settings. Most of the time-consuming choices you make in
the Query Builder are contingent on the structure of the input data sources, such as the joins involved in the query,
any filters you might define, computed columns you might design, the result items you might pick, and how the result
items are ordered for the query. Considering the large number of choices that can be made in a single query
fashioning all of these elements into a query that exactly meets your business needs can represent a large, time-
consuming effort.

SAS Enterprise Guide 5.1 extends the concept of task templates in a way to include any work that you might have
done in the Query Builder. Query-based templates are offered as a way to save the entire structure of a query and
retrieve it at a later time. This is not done in a purely data independent way like regular task templates. Rather,
guery-based templates let you modify your input data sources at the time you start the template. In this way, you can
select data that could require the same query structure as the original, but which might have different names and
locations from the original query.

Certain types of reusable query-based templates have been targeted in SAS Enterprise Guide 5.1 to be also useable
as subqueries inside the Query Builder. Specifically, query-based templates that have a single result item, but which
might return single or multiple values, can now be accessed as part of a filter condition in the Basic Filter. These

subqueries can be also be used as part of a replace condition in the Recoded Column Wizard (that you use to define
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a computed column). This use of subqueries enables you to create queries that are more dynamic in the case of
recoding columns, and in the case of filters, enables you to answer certain questions through queries that may be
difficult to organize and answer in few steps without the use of subqueries.

The purpose of this paper is to walk through how query-based templates work and how they can save you time in
SAS Enterprise Guide 5.1. Then this paper discusses how certain templates can be used to answer special problems
by turning them into subqueries in the point-and-click Query Builder interface.

REUSABLE QUERY-BASED TEMPLATES IN SAS ENTERPRISE GUIDE 5.1
HOW TO MAKE QUERY-BASED TEMPLATES

Creating a query-based template begins with designing a regular query in the Query Builder. Creating a query might
be an iterative process where you work on the query, run, review the log and results, and then work on the query
some more. After you have decided that your query is in a form you would like to be able to quickly retrieve a later
time (or from another SAS Enterprise Guide project), it is time to create the template. In SAS Enterprise Guide 5.1,
you will notice a drop-down list under the Run button in the Query Builder. Selecting the Create Template option
continues the process of making a query-based template.

-
Bl Query Builder for Local:SASHELP.CLASS M

Chitey e | Guuery Bidder | Ouputrame: WORKQUERY_FOR _CLASS

B Computed Columns | &3 Prompt Manager | 5] Preview E&Tools - Options -

E# Add Tables X Delete ElgJoin Tables | | Select Data | Fiter Data | Sort Data|

E‘E_EEE [;.I;J:tnses ) Column Name ldentifier Summary Format
i Sew s Name t1.Mame
: :% Age B Sex t1.5ex
b2 Height gﬂge t1.Age Al
Leiig) Weight Height t1.Height
@ weight t.Weight
4| m 3
[7] Select distinct rows onby

| Run v][ SaveandClose || Cancel || Hep
—_—nm fun |

m Create Template...

Display 5. Query Builder Option to Create Template
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Display 6. Creating a Query-Based Template

After you select the Create Template option from the main Query Builder interface, the Create Task Template dialog
box appears. (This is the same dialog box that appears if you were creating a template for a task.) Again, this dialog
box gives you a chance to give your template a name and description to help you pick it out later on.

HOW TO USE QUERY-BASED TEMPLATES

After you create your query-based template by clicking Create in the Create Task Template dialog box, the template

is ready to go. You are returned to the main interface of the Query Builder, where you can continue to work with that
particular query or you can close the Query Builder altogether. Now, you can access that query template in a couple
of different ways either in the same project or from a different project.

Starting a Query-based Template from the Task List

The main SAS Enterprise Guide interface features a view (in the bottom left corner by default), called the Task List.
To set focus on this area, select View->Task List. The Task List area has a drop-down list of its own that you can
use to switch between a list of available tasks sorted by name, a list of tasks sorted by category, and a list of
available task templates saved on the client machine. One way to start a saved query-based template is to select the
template name in the Task List.
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Display 8. Starting a Query-Based Template from the Task List



SAS Global Forum 2012 SAS® Enterprise Guide® Implementation and Usage

Finding Your Inner Query with SAS® Enterprise Guide®

Starting a Query-based Template from the Main Menu

Possibly the quickest way to initiate a query-based template and add that query to the process flow is to select its
name from Tasks->Task Templates. The more templates you have, however, the more difficult this menu is to

navigate.
Name Late moained Iy size
-
[# SAS Enterprise ._Gulde ——— - — - -
File Edit View | Tasks | Program Tools Help | - =4 % | Eh o= Bz (@ X |5 o[- |gqprocess Flow -
Data 4 Process Flow ~
~&eg Process Fow Pescrib : J+ Run - @ Stop | Export = Schedule - | Zoom ~ |[54 Project Log | [ Properties ~
Graph 3 ‘
ANOVA v P
Regression 3
Multivariate 3
Survival Analysis ~ »
Capability 3
Control Charts 2

m

[ Pareto Chart...

Time Series 3

Data Mining 3
OLAP 3
| Task Templates + | Task Template Manager...

AfricaWithPassword... L

Average African Country Population...

EEEEEE | E e e e EE RS

Average Age for Kids in Class...

®GEEe B

43 Refresh ‘ Disconnect [ Stop

Average Age of Class...
Average Male Weight...

@~ Servers Cake Template...

-y Private OLAP Servers Detention Girls...

DetentionBoys...

Exception Test...

Map Chart Test...

Map Chart...

MNames of kids taller than average...

Mames Subquery With Prompt... =

Oracle Template, [0 b
SASHELP.CLASS template...
Star Transtorm-ORDERDATE is a Tuesday...

atus Gusue
Template Title Test...

Test 001...
Test003...
testl04...
testd5...
testO06... — :
testld...

Read Mo profile selected | .:
1y P!

Display 9. Starting a Query-Based Template from the Main Menu

Starting a Query-based Template from the Template Manager

To open the Template Manager, select Tasks->Task Templates->Task Template Manager. The Template
Manager might be the easiest to use if you are working with a large number of templates. The templates are
presented in a list where you can sort by name, by task, and by description. Query-based templates are identified by
‘Based on Task’ of ‘Query Builder’. You can start the template by double-clicking the name, or selecting the name
and clicking Open Template.

When you are searching for a template, you can see the value in providing a meaningful name and description in the
Create Task Template dialog box.



SAS Global Forum 2012 SAS® Enterprise Guide® Implementation and Usag

Finding Your Inner Query with SAS® Enterprise Guide®

r ™
Tazk Template Manager ﬂ
T3 New » X Delete & Movelp + Move Down Import Export

MName Based on Task  Description =
B AfricaWithPassword Guery Builder
B %A\remge African Country Population Query Builder
-%ﬁ\remge Age for Kids in Class Guery Builder
: %ﬁwemge Age of Class Guery Builder
-%ﬁwemge Male Weight Query Builder
I : %Cake Template Query Builder
By Detertion Gils Cuery Builder
i % DetertionBoys Query Builder
% Exception Test Query Builder
- ¥ Map Chart Test Map Chart L
& Map Chart Map Chart 7
: % MNames of kids taller than average Guery Builder
% Names Subguery With Prompt Query Builder
: %Oﬁlde Template Query Builder
--%SRSHELP.CLASS template Query Builder A simple query based template based originally off of the SASHEL .. |
i %Star Transform-ORDERDATE is 3 Tuesday Query Builder
%Template Title Test Query Builder
i %Test 001 Guery Builder
By TestDD3 Guery Buider I
- EtestD4 Query Builder |
Hgtestnns Guery Builder B
} %testﬂ'l}ﬁ Query Builder i
| OpenTemplate ||| Cose || Hep |
———

Display 10. Starting a Query-based Template from the Template Manager

Update Query Input Data

After you start a query-based template from the Task List, main menu, or Template Manager, the next step is to
update the input data so that the template refers to data sources in the current project. The Update query input data
dialog box, which lists all of the input data sources for the query, is shown below. The original server, libref, member
name, and table alias are shown for each input data item in the query.

For each input data item, the Change button enables you to change the data source for that input item. After all of
the input data items are detected as available on the current server, a green check mark appears, and the OK button
is enabled.

10
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Display 11. Update Query Input Data Dialog Box with a Template Containing One Input Data Source

-
Update query input data u

The following data references found in the guery need to be updated with valid
data. |lse this form to specify the input data you wish to be used with the guery.

Reference: Local : SASHELP CLASS

Alias: El @

Reference:  Local : SASHELP CLASSHT

Alias: t2 @

oK || Canesl

Display 12. Update Query Input Data Dialog Box with a Template Containing Two Input Data Sources

11
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Display 13. A Query Created from a Query-Based Template

After you click OK in the Update query input data dialog box, the normal Query Builder interface appears. All of the
query selections, computed columns, filters, sorts, joins, and query options from the original query are restored. Any
data sources that refer to data not already in the project are added, and existing data items are linked to a new Query
Builder node in the process flow. From this point forward, the Query Builder behaves as it normally does when
creating a new query.

COLLABORATION

The Task Template Manager dialog box allows you to import and export templates in order to share work with others
and to facilitate moving templates created on one machine to another. It is useful to be able to share task templates
with a colleague. The ability to share query-based templates adds another convenience for groups that may have a
few individuals specializing in data management while other individuals focus on data analysis or reporting.

In some situations, the right answer might be for data managers to develop views or special processes to populate
certain tables on an agreed upon schedule. However, for those working in a SAS Enterprise Guide environment who
want a lighter weight, more flexible, and ad hoc solution, the individuals who know the data the best can use the
Query Builder to develop the correct subset of data and then ‘hand it off’ to other consumers of that data via a query-
based template. After a data analyst or report builder imports a query-based template to their client machine, the
data analyst or report builder simply selects the template to quickly add a finely tuned data set to their process flow.

12
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Display 14. The Import and Export Options in the Task Template Manager
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Display 15. Exporting a Query-Based Template to a Network Location

When exporting templates, click Export to select the location where you want to save the template on your machine
or network.

14



SAS Global Forum 2012 SAS® Enterprise Guide® Implementation and Usage

Finding Your Inner Query with SAS® Enterprise Guide®

F B
Import Task Templates ﬁ

Templates to import:

B SASHELP CLASS - Filter and sort on Name...

B SASHELP CLASS - Output to TEMP libref Ta...
%SMHELF‘.CL&SS - Sort on Mame. TaskTem...

% SASHELP CLASS template Task Template

L W . e i .

Import to group:

| Task templates ||

e

Display 16. Importing Templates

When importing task templates you can click Add to browse to a location on your machine or network.

PROBLEM SCENARIOS

What if the new input data has extra columns that do not appear in the query-based template?

If you reuse a query-based template on data that has columns in addition to those that were included in the template,
this will not affect the resulting query. So, this scenario is not really a problem. However, if you need to see those
extra columns in the output, you need to manually add them to the list of result items on the Select Data tab of the
Query Builder.

What if the new input data is missing columns that are referenced in the query-based template?

This is a problem. If you open a query-based template and change the input data to a source that does not include a
column referenced in the result item list for the query, then during the load of the main Query Builder view you will get
a warning that the Query syntax is not wvalid. If you examine the log, you will see a note that a certain
column could not be found in the table or view involved with the query.

15
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Display 17. An Indication That Something Is Amiss
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2 OPTICNS PAGENC=MIN;
3 PROC 8QL NOEXEC; 3
4 SELECT tl.Name,
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6 tl.2ge,
7 tl.Height,
a tl.Weight
5 FRCM WORK.CLASSMISSINGNAME t1;

ERRCR: Column MName could not be found in the table/view identified with the correlation name T1.
10 QUIT;

NOTE: The SAS System stopped processing this =step because of errors.

NOTE: PROCEDURE SQL used (Total process time):

real time 0.00 seconds
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11 QUIT; RUN;
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Display 18. Log from a Query Loaded from a Template on Data That Was Missing a Column Used in the
Query

After you review the log and allow the Query Builder to load, you will notice that the column appears with an unknown
data type placeholder in the result item list. In order to get the query to run error free, you can just remove this
placeholder from the query.

16
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Display 19. Placeholder for a Column Used in the Result List but Missing from the Input Data Source

A more problematic scenario is when the missing fields are referenced in a join, filter, or sort. Because of the way
joins, filters, and sorts are processed in the Query Builder, columns used in these tasks are considered more
important to the query itself. As a result, trying to match data with missing columns used in joins, filters, and sorts will
fail with a message saying that the data is incompatible with the query.

I Bk B
Query Builderl for Local:SASHELP.CLASS |8

The table WORK.CLASSMISSINGMAME that you are atternpting to switch to is not
valid for use with the current settings of this query.

Display 20. If the Missing Column Is Used in a Join, Filter or Sort, Then Different Data Needs to Be Used

In this situation if the query-based template must be salvaged because of extensive design work, a workaround can
be used to add columns if you are able to modify the input data source or copy the input data into a table which you
can modify. The following example shows syntax that could be used in a program node in SAS Enterprise Guide,
where a template references a column “Name” in a join, filter, or sort and where the table you want to modify is
Work.ClassMissingName. After the input data contains the required columns (even if these columns are empty) the
template can be opened and modified to remove the unwanted column from the query.

17
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proc sql;
alter table Work.ClassMissingName
add Name character;

quit;

What if the template output location is no longer valid?

If a query-based template was created with an output location that is a permanent SAS library, it is possible that
library will not be assigned at the time the query-based template is opened. If this happens, you are notified that the
output location is not valid. However, you are immediately given the chance to select a valid output location, either in
the Work library or some other existing library, in order to bring the query-based template back to life.

F . B
Query Builder ﬁ

P
@ The output location is not valid.
|
:

Display 21. Message Shown When Using a Template Writing to a Library That Does Not Exist

18
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Display 22. Picking a Valid Output Location

TURNING QUERY TEMPLATES INTO SUBQUERIES IN SAS ENTERPRISE GUIDE 5.1
WHAT KINDS OF SUBQUERIES ARE SUPPORTED?

A subquery, or inner query, can be thought of as a query nested inside of another query. SAS Enterprise Guide 5.1
allows the use of certain types of query-based templates as subqueries in the Query Builder. In this context, a
subquery is a previously defined query-based template that can be used as an expression in the Query Builder in
order to determine how to select rows in another table or to help determine when to recode a column in a computed
column. In general, there are a few different types of subqueries that can be used in SQL, but all of these are not
targeted in the point-and-click approach for using query-based templates as subqueries in SAS Enterprise Guide 5.1.

Here are the types of subqueries that you can create using query-based templates:

e  Subqueries that return a single value

e  Subqueries that return multiple values (multiple rows of a single field)

e Subqueries that appear as part of a filter of the raw data (on the WHERE clause)

e Subqueries that appear as part of a filter on the grouped data (on the HAVING clause)

19
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e Subqueries that appear as part of a recode condition as part of recoding a column in a computed column (on the
SELECT clause)

Here are the types of subqueries that you cannot create using query-based templates:
e Subqueries that form a derived table (subqueries that appear on the FROM clause)

e  Subqueries that refer to columns on the outer query (correlated subqueries)

SUBQUERIES AS FILTERS

Using query-based templates as subqueries enables you to create a subquery as a Query Builder expression that
informs the outer query on how to select rows. Although the subquery might happen to refer to the same table as
one involved in the outer query, its treatment will be as an independent, noncorrelated query that will return a result
set to be used by the outer query in further processing. Using subqueries in this way can allow you to organize a
query and answer certain questions that would be difficult to do in few steps without using subqueries.

Who is taller than the average child in class?

An interesting problem that can be solved using subqueries is when you need to compare a columns value to the
scalar value of a summary function. Working with the SASHELP.Class data set, consider the question, “Who is taller
than the average child in class?”.

/s Name /A Sex Jid  Age [  Height |  Weight
1 |Alfred M 14 69 1125
2 |Alice E 13 565 &
3 |Barbara F 13 65.3 1]
4 |[Carol F 14 628 1025
5 |Henry M 14 635 1025
6 |James M 12 73 23
7 |Jane F 12 R%8 845
8 |Janet F 15 £25 1125
9 | Jeffrey M 13 g25 24
10 |John M 12 g9 59.5
11 |Joyce F 11 513 505
12 | Judy F 14 643 S0
13 | Louise F 12 56.3 I
14 | Mary F 15 B6.5 112
15 |Philip M 16 72 150
16 | Robert I 12 648 128
17 | Ronald M 15 &7 133
18 | Thomas M 11 575 g5
19 |['william M ] 66.5 112

Display 23. A Grid View of the SASHELP.Class Data set

To answer this question, you need a way of determining the average for height for the whole class and at the same
time compare that value with each child’s individual height. Using subqueries can help answer this question. The
first step in tackling this problem is to design a simple query in the Query Builder. This query calculates the average
height for students in the class using a summary function. After the query is created, you can use the ‘Create
Template option to save this as a reusable query-based template.

When you run this query, you see that the average height comes out to be around 62.34.

i) AVG_of_Height|
i | £2.336842105]
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Display 24. The Average Height of All Students in SASHELP.Class

- ﬁg@_ﬁm@ge Height for Local:SASH

Query name:  Average Height Output name:  WORK AverageHeight port -
5 :
;;er:'lr‘ ﬁ Computed Columns @ Prompt Manager E. Preview EﬂTDuis - Options -
el pe
ueryl| | g Add Tables 2 Delete B Sedoct Dot | Fiter Data | Sort Data |
ams
’mar EI 1 {!IilLﬁSS ) Column Mame |dertifier Summary
roordl ame : .

AVG _of H Calculati AVG

roard| E) AVG_of_Height _Caleulation [-]

o

- =] &

— 4 1. ] b
.I Summarny groups

Automatically select groups Edit Groups... |

liscofjl No groups selected

i»

[7] Select distinct rows only

Lib

(5}

= | Bun_ 7| | SaveandClose
(=} [ .. i
et Fun

=]

SASUSER Create Template... |
{28 WORK

Display 25. Creating a Query-Based Template That Calculates Average Height
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e
Create Task Template @l@u

Name:
SASHELP CLASS - Average Height
Description:

This query contains one result tem, which is the average
height for students in the class |

@ Create a new task template in group:

Task templates -

() Beplace an existing task template:

% AfricaWith Password -
Average African Courtry Population
Averane Age for Kids in Class
Averane Age of Class

Average Male Weight

Cake Template —
Detention Girls

DetentionBoys

Exception Test

Joining SASHELP CLASS and SASHELP CLASSI
Map Chart Test

Map Chart

1] FA+q w W 1]

1| Tl | »

m

| Create | | Cancel ||

et

Display 26. Specifying a Name for the New Query-Based Template

After you save the template, you can access it again in a new Query Builder node that references the SASHelp.Class
data set. To find out who is taller than the average child in the class, you select the Name and the Height columns in
the Select Data tab of the Query Builder, and then create a basic filter based on the Height column. After selecting
the Greater than operator, click the button next to the Value field to see the Subqueries tab. This tab lists all saved
query-based templates on the client machine that have a single result item in the query. Only these queries are
eligible to be used as a subquery in a Query Builder filter.
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..... g ey ||
»
Mew Filter

1 of2  Build a basic filter gsas |

|dentifier; t1.Height

Column Name:

COperator: Greater than -

[7] Generate fitter for & prompt value (only applies to prompt types)

ﬁ Value:

| .He@‘ =

_F | Values I Columns I mepts| Subgueries
MName Description =
DetentionBoys b
Names of kids taller than average ﬂ |
Names Subguery With Prompt )
SASHELP CLASS - Average Height This guery contains one result tem, which is. .. =
Star Transform-JRDERDATE is a Tuesday =
Test 001
test004 |

o test04
b -

<]

Display 27. Reusing the Previously Saved Query-Based Template as a Subquery in a Filter

After you select the subquery, you can change its reference data source and alias in a dialog box similar to the one
that you saw when you opened a query-based template. In this case, you can just click OK to add the subquery to
the Query Builder filter.
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- —
Update subquery input data m

F

The following data references found in the subquery need to be updated with valid data. Use this
form ta specify the input data you wish to be used with the subquery.

Reference: Local : SASHELP CLASS

||| AMias: £ - l@l Change... I

Display 28. Updating the Subquery Input Data
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[ New Filter B e R - — s

1 of2  Build a basic filter Ssas.

Identifier: t1 Height

Column Name:

Operatar: (Greater than -

Subguery generated from template:  SASHELP CLASS - Average Height E]

(
SELECT /* AVG_of _Height =/
{AVGET Height)) AS AVG_of_Height
FROM SASHELP CLASS 1

' Bl [ e —
\

Display 29. The Query-Based Template Is Now a Subquery in a Filter

The portion of the query-based template that describes the entire SELECT statement is added to the Query Builder.
From this point on, it becomes a subquery and an expression in the query filter. You can manually edit the
expression from inside the filter. However, replacing the template used to import the subquery will not propagate
changes to existing query nodes containing subqueries based on the original. In this example, you are working with
filtering the raw data (FROM clause) but this process works just the same for filtering summarized data (HAVING
clause).
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(Newfiter 7 0% TR T e e
2 of2  Summary of properties gsas

|dentifier: t1_Height |

Git1.Height)) AS

FROM SASHELP.CLA

|
l. ,:I
I | =
I <Back i'” Next> |[ Finish H Cancel H Help ]

Display 30. Summary of Properties for the new Subquery
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% Taller Than Average Students fur Luml:ShSH'ELFCLASS" u
Guery name:  Taller Than Average Stlzd_ents Output name: 1:"I.I'CIF'LHZT.nf'u.l__LEH Change..
B Computed Columns | &5 Prompt Manager | [55] Preview EﬁTouts ~ | [ Options -
i% Add Tables _| | Select Data | Fitter Data | Sort Data
N
= g Ed:is ) Fitter the raw data Operator
...... @ Sen = @ Where 5 _,’I
@ Age - NP t1 Height > ( SELECT /* AVG_of_Height */ (AVGit1.Heig...
@) Heidht )
| e X
|
||
||
||
]
|
' I
! | R v|| SaveandCiose || Cancel || Hep |
b

Display 31. The Subquery as it Appears in the Filter Data Tab

Running this Query Builder node now produces a list of student names along with height. These students all are
taller than the class average of 62.34.

/A Name (@  Height
1 |Alfred 69
2 |Barbara €53
3 |Carol 628
4 |Henry 635
5 |Janst E25
& |Jeffrey 625
F  |Judy 643
B |Mary 665
9 | Philip T2
10 | Robert £48
11 | Ronald &7
12 | William £E5

Display 32. Students Taller than the Average Height of 62.34
The SQL generated for this query shows the subquery wrapped in parentheses inside the WHERE clause:

PROC SQL;
CREATE TABLE WORK.TALLER (label="QUERY FOR CLASS”) AS
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SELECT t1.Name,
tl.Height
FROM SASHELP.CLASS tl
WHERE tl.Height > (
SELECT /* AVG of Height */
(AVG (tl.Height)) AS AVG of Height
FROM SASHELP.CLASS tl

QUIT;

This use of subqueries answers a unique type of problem. You can imagine this type of query being used to answer
questions like the following listed below. Beside each question is the SASHELP data set that you can use to explore
for the answer.

e Where has there been recorded higher than average actual sales? (SASHelp.PrdSal3, using the Actual column)

e Where have the predicted sales been more accurate than average? (SASHelp.PrdSal3, by comparing the Actual
and Predicted columns)

e Out of the people who had a higher than average cholesterol and who had high blood pressure at the time of
data collection, how many people were also heavy smokers? (SASHELP.Heart, using the Cholesterol,
BP_Status, and Smoking_Status columns)

To answer these questions without subqueries, you might need to determine the value of the summary function and
save it off to a separate table; merge the result back to match every row in the main table in question; and then create
a filter that compares the individual row values to the aggregate that has now been duplicated on every row in the
main table. A subquery in this case offers a more elegant solution.

In One Table but Not Another

Another interesting problem subqueries can help with is when you need to select records from one table that cannot
be matched to records in another table. For example, consider a case where all the twelve-year-olds in the
SASHELP.Class data set are acting up and have their names placed in a Detention data set. You could run the
following code in a program node to create this data, or you could use a simple Query Builder node to create the

data:
proc sqgl;
create table WORK.ClassDetention as
select tl.Name
from sashelp.class tl
where tl.Age = 12;
quit;

Supposing you do not know that it is the twelve-year-olds who are acting up. Instead, you want to answer the
question, “Who in the SASHELP.Class data set was not put into detention?”. You can use a subquery to answer this
question. The first step is to create a query-based template from a simple Query Builder node that uses the
WORK:.ClassDetention. In the query, no filter is applied and you select only the Name column. After that template is
created, another Query Builder that runs against the SASHELP.Class data set can use this template as a subquery to
determine which students are not in the Detention data set.
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f |

and Mew Filter

| 1 of2 Build abasic filter Ssas ‘=

=]

|dentifier: t1.Mame

Column Mame: MName

Operatar: [Nﬁth a list v]

[ e R — =]
| Values I Promptz | Subgueries

W Mame Description

SASHELP HEART - AVG of Cholest ...
SASHELP HEART - STD of Cholest... The 5TD of cholestenol for the SA..
Star Transform-ORDERDATEIsa T..

:: Test 001

n testDO4

) test04 =
Il WORK ClassDetention - Names A list of names for children in deten...

| ok || Cancel _]:;l

T

Display 33. Using a Subquery That Returns More than One Row

In this example, the subquery returns more than one row. The result set includes all the names in the
WORK:.ClassDetention data set. To use this as part of a Query Builder filter, you need to use either the In a list or
Not in a list operator. Because in this case you want to find out whom in the SASHELP.Class data set is not in the
list of names in the WORK.ClassDetention data set, the operator to use is Not in a list. When you run the resulting
query, the result shows the fourteen students do not have their name listed in the WORK.ClassDetention data set.
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/s Name i@  Age
1 |Alfred 14
2 |Alice 13
3 |Barbara 13
4 |Carol 14
5 |Henry 14
6 |Janet 158
T | Jeffrey 13
& |Joyce 11
9 |Judy 14
10 |Mary 15
11 | Philip 16
12 |Ronald 15
13 | Thomas 11
14 |Wwilliam 15

Display 34. The Good Kids

The resulting SAS code generated from this Query Builder shows the subquery nested inside of parentheses inside
the WHERE clause. Again, this process would work the same way if the need was to filter on the summarized data
(using a HAVING clause):

PROC SQL;

CREATE TABLE WORK.NOTINDETENTION (label="QUERY FOR CLASS”) AS
SELECT tl1.Name,

tl.Age
FROM SASHELP.CLASS tl
WHERE tl.Name NOT IN

(

SELECT tl.Name

FROM WORK.CLASSDETENTION tl

QUIT;

Things to Remember

When you are working with a query-based template as a subquery that returns a single value, you can use the
following filter operators:
e Equalto

Not equal to

e Lessthan

e Lessthan or equal to
e  Greater than

e  Greater than or equal to

When you are working with a query-based template as a subquery that returns multiple rows for a single column, you
can use the following filter operators:
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e Inalist

e Notinalist

Subqueries and Joins

When working with subqueries that return multiple values, in many cases the resulting query could be redesigned to
accomplish the same result by using a join in combination with a filter. If you consider the problem where you want to
find rows in one table that are not in another table, the same thing could be achieved by joining the
WORK.ClassDetention table with the SASHELP.Class table using a RIGHT JOIN and then including a filter to include
a condition where a column from the WORK.ClassDetention table was null.

rﬁf- Tables and Joins #‘L -_— ¢ e . @@lﬁ

ik Add Tables 2% Delete [i] Properties @b Join Order |2l Table - [ Options = & Move Up =
t1 ( CLASSDETEN ... = £2 [ CLASS )
Name -—_‘il—b- MName
Sex
Age
Height
Weight
Join Order
RIGHT JOIN: t1.Name =t2.Mame
| Cose || Hebp

Display 35. Using a Join to Find Rows in One Table That Are Not in Another Table
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F |
% Not In Another Table Join for Local WORK.CLASSDETENTION ﬁ

GQuery name: N.oi -In ﬁnuther Ta-t;le Join Cutput name: WOH KOUEHY_FOH_C U\SSDI:—I'ENTION Change...

i Computed Columns | &) Prompt Manager | 55| Preview |G Tools - | [ Options -

F Add Tables 3 Delete &g Join Tables | | Select Data | Fiter Data | Sort Data|

E‘ Eﬂt{; EJ';‘:”SESDEI—ENTDN ) Filter the raw data Operator
£-E5 £2(CLASS) = £ Where
: & Mame - t1.Name ="
4@, Sex
@ Aee
{2 Height X
..... @ Weight @
[ Bun vJ [ Save and Close ] [ Cancel ] I Help ]

b

Display 36. Using a Filter to Weed Out the Records from One Table in a Query

The resulting code generated from this query returns the same fourteen ‘good’ kids that the earlier subquery example
did. Here is the generated code:

PROC SQL;
CREATE TABLE WORK.QUERY FOR CLASSDETENTION AS
SELECT t2.Name,
t2.Age,
FROM WORK.CLASSDETENION t1
RIGHT JOIN SASHELP.CLASS t2 ON (tl.Name = t2.Name)
WHERE tl.Name = ‘';

QUIT;

When working with subqueries that return multiple values and use the In a list operator, you often are performing the
same thing as a query that contains an INNER JOIN. There might be some cases where a subquery is more efficient
in retrieving data. The best choice depends on the options being used by the back-end database, the properties of
the tables involved, and the query itself. However, generally speaking a join is probably going to be as efficient or
more efficient for this purpose.

There are nevertheless a couple of compelling reasons to use subqueries for join-like behavior in some Query Builder
filters in SAS Enterprise Guide 5.1. The first reason you might want to use subqueries is increased readability. In the
previous example when comparing the Query Builder node using a subquery to the one using a RIGHT JOIN, it is
easier to understand what is happening in the case of the subquery. The structure of the query seems to match how
you would logically think about the problem -- first selecting from the target table you have in mind and then adding a
condition that goes and checks against another table. The case of the join requires you to understand the query and
its purpose as a whole before you can understand what is happening and why in the selected items, join, and filter
condition.

A second reason to make use of subqueries in some cases for join-like behavior is maintainability. If you work in an

established data environment where tables are organized into a knowable design like a star schema, you can create
reusable query-based templates that target the key fields for tables you often work with. If you need columns in the

output from multiple tables, you will always need joins. However, in cases where the complicated joins are needed
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just for the sake of hunting for records in a single table, using query-based templates as ready-to-go subqueries
might be easier and faster to work with from a development perspective.

The ability to quickly develop and easily use queries that perform join-like behavior through subqgueries can be
extended further by designing the subquery to include a filter that references a prompt. If a table includes a column
representing a transaction date or perhaps a date for when the record was last updated, a subquery targeting the key
for this table might also include a prompt in the filter for date. This prompt enables you to supply join information
between tables at run time, which might prove very useful in ad hoc analyses on a set of large relational data tables.

Here is a simple example. Consider the earlier example table of WORK.ClassDetention. This table is comprised
simply of a list of names and nothing else. If you wanted to query this table and pick out only the boys or only the
girls and you wanted to make that choice at run time, then using a prompted subquery targeting the SASHELP.Class
table inside a query against the WORK.ClassDetention table would let you do that. To look at this example, you first
need to use the SAS Enterprise Guide prompt manager to create a text type prompt that would allow you to pick
either ‘F’ (for girls) or ‘M’ (for boys) when run.

i ™
=] Add New Prompt m

Genergl | Prompt Type and Yalues |

Prompt type:
[Text 7]

Method for populating prompt: Mumber of values:
[ |ser selects values from a static list - l [Slngle value -
Minimum length: Madmum length:

Include Special Values

[] Al possible values  [] Missing values

[] Append formatted values with unformatted values
List of values:

Unformatted Value Formatted (Displayed) Value Default | Add
c
M O
| ok || Canced || Hebp |

e

Display 37. Setting Up a Prompt to Use with a Subquery

With the prompt created, the next step would be to create a reusable query-based template that would represent the
‘join-like’ behavior that you would like to make dynamic. In this case, it will be a query on the SASHELP.Class table
with a filter on the Sex column that refers to the ‘Sex’ prompt we just created.
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Mew Filter

=
1 of2  Build a basic filter gsas

|dentifier: t1.5ex

Column Name:

Operator: [Equa] to -

Generate filter for @ prompt value (only applies to prompt types)

Walue: ;1;5&: B

%_eg_WhereParam(t1.Sex, Sex, EQ, TYPE=S, IS_EXPLICIT=0)

[ ] Encloze values in quotes [] Use formatted dates

Back || [ MNex» | [ Finish | [ Cancel | [ Help

Display 38. The Filter Defined Here Will Drive the Dynamic ‘Join’

At this point, you can save the query as a template, and a new query (to come up with the final solution to this
problem) can be started against the WORK.ClassDetention table. In this query, the Name value is added to the
result list in the Select Data tab in the Query Builder, and a basic filter is initiated. In the filter, you choose the In a
list operator and then import the query-based template that you just created for the SASHELP.Class table as a
subquery. This subquery provides a list of ‘keys’ (which in this case are names) of either boys or girls depending on
the value chosen in the prompt at run time.
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F )
By Query Builderl for Local WORK.CLASSDETENTION [ = |
Query name:  Query Buider] Output name:  WORK QUERY_FOR_CLASSDETENTION

& Computed Columns | &) Prompt Manager | 53] Preview | B Tools » Options =
% Add Tables 3 Delete g Join Tables | | Select Data | Fitter Data | Sort Data |
£-E53 t1 (CLASSDETENTION ) e .
feglly, Name o=
(%]

[ New Filter [ = ] (@)

3 of4  Build a basic filter Ssas

=,

B [X|

Identifier: t1.Name

Column Name: Name

Operator: In a list =

[ Generate filter for a prompt value {only applies to prompt types)

o I p——— I |
| Values | Prompts | Subgueries
Mame Description -
Mames Subguery With Prompt
SASHELP.CLASS - Average Height This query contains one resuft item, which is ...

SASHELP CLASS - Prompted Sex

SASHELP HEART - Average Smoking Years...

SASHELF HEART - AVG of Cholesterol

b | SASHELP HEART - STD of Cholesterol The STD of cholesterol for the SASHELP H...
Star Transform-ORDERDATE is a Tuesday

Stocks - MAX adjusted close for IEM -

fomJ

Display 39. Prompted Subqueries Used as a Dynamic Join
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-
@ Specify Values for Project Prompts u
| General Heset group defaults |
Sex

(v =

_I

| [_Run_ ][ Cancel

Display 40. Providing the Prompt Value at Runtime

When the query is run, the value that you pick in the prompt is fed into the subquery and used to drive the logic in this
‘join-like’ example. Here is the code for this example:

PROC SQL;
CREATE TABLE WORK.QUERY FOR CLASSDETENTION AS
SELECT tl1.Name,
FROM WORK.CLASSDETENION t1l
WHERE tl.Name IN
(
SELECT tl.Name
FROM SASHELP.CLASS tl

WHERE % eg WhereParam(tl.Sex, Sex, EQ, TYPE=S, IS EXPLICIT=0)

QUIT;

RECODING COLUMNS USING SUBQUERIES

In SAS Enterprise Guide 5.1, subqueries enable you to add a dynamic element to how you can create a computed
recoded column by using these subqueries as an expression in a replace condition. If you consider a query against
the SASHELP.Class table, you can use this feature to create a new character column that will read ‘Was found in
detention’ or ‘Was NOT found in detention’ based on what a subquery finds when run against the
WORK.ClassDetention table. In the Specify a Replacement dialog box, the process for importing a reusable query-
based template as a subquery functions the same as when creating a basic filter on the Filter tab of the Query
Builder.

36



SAS Global Forum 2012 SAS® Enterprise Guide® Implementation and Usage

Finding Your Inner Query with SAS® Enterprise Guide®

-
Specify a Replacement m
| Replace Values | Replace a Range | Replace Condition |
|dentifier: t1.Mame
Column Name: Mame
Cperator: In & list -
Subguery generated from template: WO RK ClassDetention - Mames E]
SELECTt1.Mame
FROM WORK CLASSDETENTION t1
With this value:
Was found in detention E]
Enclose this value in guotes
| oK || Cancel || Hep | |
i

Display 41. Using a Subquery as a Replace Condition for a Recoded Column
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i N
Edit Computed Column M
1 of2 Specify a replacement (Ssas
Replacement Cther values
Hisdace With Replace all other values with:
IN{ SELECTt1MNa.. "Wasfound in detertion’ ) The gument value
() A missing value
@ Specify a value:
Was NOT found in detertion [ .. |
Enclose value in guotes
Column type
@ Character
Add. || Edi. || Dekte | O Numeic
| Back |v|[ MNexts || Finish |[ Cancel | [  Hebp
e

Display 43. Specifying the Replacement Value Used when the Subquery Condition is Matched

A Name )i Age |/ Detention
1 |Alfred 14iWwas NOT found in detention
2 |Alice 13i'Wwas NOT found in detention
3 |Barbara 13i'wlas NOT found in detention
4 | Carol 14:i'Was NOT found in detention
5 |[Henry 14i'wias NOT found in detention
6 |James 12i'\was found in detention
7 |Jane 12i\wa= found in detention
£ |Janet 15:i'was NOT found in detention
g | Jeffrey 13i'Was NOT found in detention
1D | John 12:'\was found in detention
11 |Joyce 11i'was NOT found in detention
12 |Judy 14i'wias NOT found in detention
13 | Louise 12i\was found in detention
14 | Mary 15i'\wfas NOT found in detention
15 |Fhilip 16i'w'as NOT found in detention
16 | Robert 12:\was found in detention
17 | Ronald 15iWas NOT found in detention
18 | Thomas 11i%as NOT found in detention
19 ['Wwilliam 15i'\wfas NOT found in detention

Display 44. Results from Using a Subquery in a Recoded Column
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The resulting code shows the subquery nested inside the CASE function in the SELECT statement:
PROC SQL;
CREATE TABLE WORK.QUERY FOR CLASS AS
SELECT tl1.Name,
tl.Age,
/* Detention */
(CASE

WHEN tl1.Name IN

SELECT tl.Name
FROM WORK.CLASSDETENTION t1
) THEN ‘Was found in detention’
ELSE ‘Was NOT found in detention’
END) LENGTH=50 AS Detention
FROM SASHELP.CLASS t1;

QUIT;

CONCLUSION

The purpose of this paper was to explore the new features of reusable query-based templates and subqueries in the
SAS Enterprise Guide 5.1 Query Builder, to understand how these templates are used, and why you might want to
use them.

Reusable query-based templates are offered in SAS Enterprise Guide 5.1 as an extension to the existing task
template feature. Query-based templates enable you to save time-consuming work that you have done in the Query
Builder designing queries. These templates also enable you to quickly add those queries to a process flow at a later
time and possibly with different data. Combined with the ability to import and export templates through the Template
Manager, query-based templates can increase the ease of collaboration between colleagues in an organization
where some individuals might specialize in data management and others might focus more on analysis or reporting.

The SAS Enterprise Guide 5.1 Query Builder enables you to reuse query-based templates with a single result item as
subqueries. As a result, you can solve special problems as well as facilitate logical query design and ease of
development. Using a subquery inside a recoded computed column opens up the possibility for dynamic recoding
conditions where the logic for recoding information in one table is controlled by values in another. Using a subquery
that returns a single value in a filter can let you do things with your query that would be difficult to do any other way,
such as filtering a table based on subsets or aggregated values from the same or another table. Subqueries also
enable you to perform filtering operations in substitution for a join. Depending on your data, using subqueries might
not be more efficient from a performance standpoint, but in some cases, it does allow for a more elegant query
design that is easier to design, understand, and maintain. Finally, combining that type of subquery with a prompt
allows for join criteria to be driven by user choices at run time. This might facilitate ad hoc analyses in a data
environment where you are constantly hunting for subsets of records in a single table driven by certain date ranges or
other criteria stored in another table.
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